
Amendments:

07/08/2001
TN2000 & TN3270 Setup, Print Queues, documented the secondary menu.

03/11/2001
TN2000 & TN3270 Version History: Added changed to 2.3/1.3.

03/11/2001
TN2000 & TN3270 Renamed the help file from LPD.hlp to SDILPD.hlp and TSILPD.hlp " and the exe file name from 
lpd.exe to sdilpd.exe and tsilpd.exe.
TN2000 & TN3270 Added the follow to the View menu: Log File, Control File, Data File.
TN2000 & TN3270 Print Queue Setup Dialog: Added "Suppress initial form feed", "Append form feed to end of job" 
and "Use lines per inch".

12/14/2001
TN2000 & TN3270 Lpd printer queue setup – Added "Send raw data to printer"

11/28/2001
TN2000 & TN3270 Added "Sending z/OS TSO Print Files to LPD."

11/06/2001
TN2000 & TN3270 Added "XP" to the operating system lists.

05/11/2001

TN2000 & TN3270 Added logo to heading of each topic
TN2000 & TN3270 Added "ME" to the operating system lists.
TN2000 & TN3270 Moved "Restrictions"to the overview section.



TN3270 Plus LPD Help Contents (.cnt) file damaged

The TN3270 Plus LPD help contents file has been damaged or erased, please reinstall TN3270 Plus LPD or send an 
e-mail to support@sdisw.com.
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Introduction 

TN3270 Plus LPD is a 32-bit print daemon that accepts print jobs from a remote computer and prints them on a 
Windows printer. TN3270 Plus LPD runs on Windows XP, 2000, NT, ME, 98 or 95. Any computer operating system 
that supports LPR (VSE, VM, MVS, OS/390, OS/400 and UNIX) can send print jobs via TCP/IP to TN3270 Plus LPD. 

The diagram below the illustrates the print job flow:

See Also:
Features

Getting Started



Features

Protocol: Line Printer Daemon Protocol (LPD). (RFC 1179).
Printers: Supports local and network printers.
System Tray: Can run in the system tray.
Banner Page: Supports banner pages. 
Fonts: User selectable fonts.



Restrictions

TN3270 Plus LPD does not support the following:

• Mail when printed

• Plot CIF (CalTech Intermediate Form) files

• DVI files

• Postscript files

• Raster files

TN3270 Plus LPD does not run on Windows 3.1x.



Version History 

Changes TN3270 Plus LPD to Version 2.3, July 2002

Enhancements and Corrections:
Log File: Added "View, Log File" menu item.
Control and Data files: Added "View, Control File" and "View, Data File" menu items.
Print to Disk File: Added an option to allow jobs to be printed to a disk file.
Use Lines Per Inch Added the "Use lines per inch" option to control vertical spacing on 

printed output.
Form Feed: Added "Suppress initial form feed" and "Append form feed to end of 

job" options.

Changes TN3270 Plus LPD to Version 2.2, August 2001
There have been no changes to this release of TN3270 Plus LPD.

TN3270 Plus LPD Initial Release Version 2.1, November 2000



Getting Started

1. Click on the Start button, select Programs, select TN3270 Plus, double-click on TN3270 Plus LPD.

2. Create a print queue to receive your print files. 

3. You may minimize TN3270 Plus LPD to the system tray by opening the Setup menu and selecting Run in 
System Tray. To maximize the TN3270 Plus LPD window, right click on the System Tray icon and click on 
the Restore command in the pop-up menu. 

4. If you want TN3270 Plus LPD to start every time you reload Windows, you should add a shortcut to 
sdilpd.exe to your Windows Startup Folder (Start, Settings, Taskbar & Start Menu..., Start Menu Programs 
tab, Add... button, Browse... button, navigate to sdilpd.exe, Open button).    



Creating LPD Print Queues

You must create one or more print queues to receive print files from a remote computer. The LPR routines on a 
remote computer send print files to a specific print queue. You may want to set up different print queues to be 
connected to different Windows printers or that use different print options. For example, you may want one print 
queue that prints on your local printer and another that prints on a network printer. 

The following procedure outlines how to setup a print queue. 

1. Open the TN3270 Plus LPD Setup menu, click on Print Queues... and click on New Queue… 

2. In the Save As dialog box, fill in a print queue name (for example, AS400).

3. Configure your queue using the instructions in the Print Queue Setup dialog box topic. 



Sending Print Files to LPD

Once TN3270 Plus LPD is running, it can receive print jobs from remote computers via TCP/IP. Any computer on the 
network (intranet or Internet) that supports LPR can send the print jobs to TN3270 Plus LPD. See the following topics 
for information on printing to TN3270 Plus LPD in your environment. 

Sending AS/400 Print Files to LPD
Sending VSE/ESA Print Files to LPD
Sending VM/ESA Print Files to LPD
Sending z/OS TSO Print Files to LPD



Sending AS/400 Print Files to LPD

This section outlines how to send print files from an AS/400 to TN3270 Plus LPD. Additional information about LPR 
on the AS/400 is in the following IBM manuals:

OS/400 TCP/IP Fastpath Setup (SC41-5430)
OS/400 TCP/IP Configuration and Reference (SC41-5420)

Send a Spool File to TN3270 Plus LPD
Use the following steps to send an existing spool file from the AS/400 to TN3270 Plus LPD. After the connection is 
working, you may want to set up an AS/400 print queue that automatically routes prints jobs to TN3270 Plus LPD. 
Those steps are described in the next section of this topic.    

1. Create an SCS (SNA character String) print queue in LPD. This LPR example sends SCS formatted print 
files, so check the SNA Character String (SCS) printer check box when the queue is created. This 
example also uses a print queue name of AS400.

2. On the AS/400, locate the spool file you want to send to TN3270 Plus LPD. Issue the Work with Spooled 
Files (WRKSPLF) command to see your spooled files. Press PF10 to display the job information for the 
spooled files. Make a note of the file, job, user name, job number and spool file number.

3. Issue the Send TCP/IP Spooled File (SNDTCPSPLF) command. For example:

SNDTCPSPLF RMTSYS(*INTNETADR) INTNETADR('1.2.3.4')
RMTPRTQ('AS400') FILE(FILE3)
JOB(000480/STEVE/TESTJOB)
SPLNBR(2) DESTTYPE(*OTHER) TRANSFORM(*NO)

Where:

RMTSYS(*INTNETADR) *INTNETADR indicates the IP address of
the computer running TN3270 Plus LPD 
is specified in the INTNETADR 
parameter. 

INTNETADR('1.2.3.4') 1.2.3.4 is the IP address of the computer 
running TN3270 Plus LPD.

RMTPRTQ('AS400') AS400 is the TN3270 Plus LPD print 
queue set up for receiving jobs from the 
AS/400.

FILE(FILE3) FILE3 is the spool file name.
JOB(000480/STEVE/TESTJOB) 480 is the job number.

STEVE is the user name.
TESTJOB is the job name.

SPLNBR(2) 2 is the spool file number.
DESTTYPE(*OTHER) *OTHER indicates the remote system is 

not an AS/400.
TRANSFORM(*NO) *NO indicates the SCS data will not be 



translated to ASCII.

4. If you are unable to print, use the AS/400 PING command to verify the connection with the computer running
TN3270 Plus LPD. For example:

 PING RMTSYS(*INTNETADR) INTNETADR('1.2.3.4')

Create an AS/400 Printer Queue for LPD Printing
This section outlines how to create a printer queue on the AS/400 specifically for LPD printing. All print files spooled 
to this queue are routed to TN3270 Plus LPD.

Use the Create Output Queue (CRTOUTQ) command to create a printer queue on the AS/400. For example, create a
AS/400 printer queue named "PRT2LPD" that routes print jobs to TN3270 Plus LPD queue "AS400" at IP address 
"1.2.3.4".

CRTOUTQ OUTQ(PRT2LPD) RMTSYS(*INTNETADR)
INTNETADR('1.2.3.4') AUTOSTRWTR(1)
RMTPRTQ('AS400') CNNTYPE(*IP) 
DESTTYPE(*OTHER) TRANSFORM(*NO)

Where:

OUTQ(PRT2LPD) PRT2LPD is the OS/400 output queue name.
RMTSYS(*INTNETADR) *INTNETADR indicates the IP address of the 

computer running TN3270 Plus LPD is specified
in the INTNETADR parameter.

INTNETADR('1.2.3.4') 1.2.3.4 is the IP address of the computer 
running TN3270 Plus LPD.

RMTPRTQ('AS400') AS400 is the print queue name defined in 
TN3270 Plus LPD. See Configure an SCS Print 
Queue in TN3270 Plus LPD at the beginning of 
this chapter.

AUTOSTRWTR(1) 1 autostarts one writer for the queue.
CNNTYPE(*IP) *IP indicates a TCP/IP connection. 
DESTTYPE(*OTHER) *OTHER indicates the remote system is not an 

AS/400.
TRANSFORM(*NO) *NO indicates the SCS data will not be 

translated to ASCII.

Sending VSE/ESA Print Files to LPD

This section outlines how to send print files from VSE/ESA to TN3270 Plus LPD. Additional information about LPR on 
VSE/ESA is in the following manuals:

TCP/IP for VSE User's Guide 



TCP/IP for VSE Programmer's Reference 

Configure a TN3270 Plus LPD Print Queue for VSE/ESA Print Files 
Before you can send print files from VSE/ESA LPR to TN3270 Plus LPD, you must create a print queue in LPD. 

There are 4 methods of sending print jobs from VSE to LPD:

1. Using the LPR CICS transaction.

2. Using the Automatic LPR client (AUTOLPR) facility to send output from a job to LPD.

3. Using the LPR batch client to print a file and send it to LPD.

4. From an application program using the sockets interface. 

The first 3 methods are discussed in detail in the TCP/IP for VSE User's Guide. The last method is discussed in the 
TCP/IP for VSE Programmer's Reference.



Sending VM/ESA Print Files to LPD

This section outlines how to send print files from VM/ESA to TN3270 Plus LPD. Additional information about LPR on 
VM/ESA is in the following manuals:

VM RSCS Planning and Installation (SH24-5219)
VM RSCS Operation and Use (SH24-5220) 
 

1. Create a TN3270 Plus LPD Print Queue for VM/ESA print files 
Before you can send print files from VM/ESA LPR to TN3270 Plus LPD you must create a print queue in LPD. This 
example uses a print queue name of VMPRTQ.

2. Configure an LPR link in RSCSTCP CONFIG
The following is an example of the LINKDEFINE and PARM statements required for an LPR link. These statements 
must be added to RSCSTCP CONFIG on TCPMAINT 198. 

Note: RSCS must be shutdown and restarted for the changes to RSCSTCP CONFIG to take affect.

LINKDEFINE LPRONE TYPE LPR AST CLASS *
PARM LPRONE EXIT=LPRXONE HOST=1.2.3.4 PRINTER=VMPRTQ

Where:

LINKDEFINE LPRONE LPRONE is the name of the link. This name is 
specified on the CMS TAG command to indicate
where to send a spool file. 

TYPE LPR indicates this is an LPR link.
AST indicates the link will be autostarted when a file 

is sent to it.
CLASS * indicates all file classes may be processed by 

the link.
PARM LPRONE Parameter statement for the LPRONE link.
EXIT=LPRXONE specifies the exit module for this link. 

LPRXONE is the default exit module provided 
by IBM for non-postscript printers

HOST=1.2.3.4 1.2.3.4 is the IP address of the computer 
running TN3270 Plus LPD.

PRINTER=VMPRTQ VMPRTQ is the TN3270 Plus LPD print queue 
set up for receiving jobs from VM/ESA.

3. Print a File 
Logon to a CMS user and enter the following commands to print the file PROFILE EXEC to the VMPRTQ print queue 
in TN3270 Plus LPD.



spool prt rscs
tag dev prt lprone
print profile exec

Where:

spool prt rscs Spools print files to the RSCS reader
tag dev prt lprone Adds a tag to all files in the print queue 

indicating they are to be routed to printer 
link "lprone". 

print profile exec Prints the profile exec file. This file will be 
spooled to the RSCS reader and RSCS 
will route it in LPR format to the IP 
address in the LPRONE link.

Sending z/OS TSO Print Files to LPD

This section outlines how to send print files from z/OS, OS/390 or MVS TSO to TN3270 Plus LPD. Additional 
information about LPR on z/OS is in the following manuals:

OS/390 eNetwork Communications Server: IP User's Guide, GC31-8514
CS for OS/390 TCP/IP Implementation: MVS Applications, SG24-5229-01
 

1. Create a TN3270 Plus LPD Print Queue for z/OS print files 
Before you can send print files from TSO LPR to TN3270 Plus LPD you must create a print queue in LPD. This 
example uses a print queue name of ZOSPRTQ.

2. Print a File 
Logon to TSO and enter the following commands to print the file sys1.tcpparms(lpddata) to the ZOSPRTQ print 
queue in TN3270 Plus LPD. In this example, the IP address of the PC running TN3270 Plus LPD is 1.2.3.4

TSO LPRSET ZOSPRTQ@1.2.3.4
TSO LPR 'SYS1.TCPPARMS(LPDDATA)'

Where:

TSO LPRSET 
ZOSPRTQ@1.2.3.4

Sets your default TCP/IP printer 
destination. ZOSPRTQ is the TN3270 
Plus LPD printer queue name and 
1.2.3.4 is the IP address of the PC 
running TN3270 Plus LPD.

TSO LPR 
'SYS1.TCPPARMS(LPDDATA)'

Prints data set 
SYS1.TCPPARMS(LPDDATA) to the 
default TCP/IP printer.



File menu commands

The File menu contains the following commands:

Print... Print a job from the print queue.

Delete Delete a job from the print queue.

Close Closes the TN3270 Plus LPD window.

Edit menu commands

The Edit menu contains the following commands:

Select All Select all print jobs.

Deselect Deselect selected print jobs.



View menu commands

The View menu contains the following commands:

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Log File View the contents of the log file.

Control File View the contents of    the control file.

Data File View the contents of the data file.

Setup menu commands

The Setup menu contains the following commands:

Print Queues... Tailor your print queues.

Run in System 
Tray...

Toggle the system tray option on or off.

Trace Socket... Turns TCP/IP socket tracing on or off.



Help menu commands

The Help menu contains the following commands, which provide you assistance with this application: 

Help Topics Displays the table of contents for the help 
file. This command also gives you access to 
the help index and the help find function.

About TN3270 
Plus... 

Displays the version number and build date 
of this application.

System Tray menu commands

The System Tray menu is displayed by right-clicking the TN3270 Plus LPD icon in the system tray. TN3270 Plus LPD 
runs in the system tray when the Run in System Tray option is on (Setup, Run in System Tray)

Restore Restore the TN3270 Plus LPD window.

About Display the About dialog box. 

Exit Exit TN3270 Plus LPD.

Print command (File menu)
File Print

Print a job from the print queue. 

Shortcuts:

Standard Toolbar 

Keys: Ctrl+P



Delete command (File menu)
File, Delete

Delete a job from the print queue. 

Shortcuts:

Standard Toolbar 

Keys: Delete



Close command (File menu)
File, Close

Close the TN3270 Plus LPD window.

When the Run in System Tray option is off, the application is closed. When the Run in System Tray option is on, the 
TN3270 Plus LPD window is closed, but the application remains running in the system tray. 

Shortcuts:
None



Select All command (Edit menu)
Edit, Select All

Select all print jobs currently in the print queue.



Deselect command (Edit menu)
Edit, Deselect

Deselect selected print jobs.



Toolbar command (View menu)
View, Toolbar

Display or hide the Toolbar.    A check mark appears prior to the menu item when the toolbar is displayed.



Status Bar command (View menu)
View, Status Bar

Display or hide the Status Bar. The Status Bar shows messages and information that describe the state of the 
application. A check mark appears prior to the menu item when the Status Bar is displayed.



Log File command (View menu)
View, Log File

View the contents of the log file. The log file is a time-stamped file containing a record of all print jobs received.



 (View menu)
View, Control File

View the contents of the control file for the selected print job. Each print job is composed of two files, the control file 
and data file. The control file contains print control information and the data file contains the text to be printed.



Data File command (View menu)
View, Data File

View the contents of the data file for the selected print job. Each print job is composed of two files the control file and 
data file. The control file contains print control information and the data file contains the text to be printed.



Print Queues command (Setup menu)
Setup, Print Queues..., queue_name or New Queue…

Tailor your print queues. A secondary menu allows you to select an existing print queue or select New Queue… 
Selecting an existing queue displays the Print Queue Setup dialog box so you can modify the print queue settings. 
Selecting New Queue…, displays the Save As dialog box. Enter the print queue name in the Save As dialog box and
click OK. The Print Queue Setup dialog box appears so that you can tailor your new print queue.



Print Queue Setup dialog box
Setup, Print Queues..., queue_name

The Print Queue Setup dialog box contains all the customization options for your printer queues.

Print Queue Select a print queue from the drop-down list box. Click on the New 
button to create a new print queue. Click on the Delete button to 
delete a print queue. You must delete all jobs in the print queue before 
the print queue can be deleted.

Printer Select the printer from the drop-down list box. Click on the adjacent 
Page Setup... button to the Page Layout dialog box and change the 
printer setup for this session. 

<<Disk File: append>> indicates print output should be appended 
to the file specified in the Filename edit box rather than printed. If the 
file does not exist, it is created.

<<Disk File: by job number>> indicates print output should be sent
to a file rather than printed. A new file will be created for each new 
print job. 

Filename (Optional) Specify the full path and file name to redirect printed output 
to a file. You must specify <<Disk File: append>> or <<Disk File: 
by job numberl>> in the Printer drop-down list box to enable this edit
box. Click the Browse... button to display the Select Printer Screen 
File Name dialog and choose a file.

Font Select a font for this print queue. Click the adjacent Change... button 
to change the font and/or font size.

Spool Folder Specify a folder to contain jobs in the print queue. Click the adjacent 
Browse... button to select a folder.

Pause printing Check this box to pause printing for this queue. Uncheck this box to 
restart printing. 

Suppress banner page Check this box to suppress the banner page. 
Hold jobs in queue after printing Check this box if you do not want print jobs deleted 

after they are printed. 
Hold jobs in queue without printing Check this box if you want to save prints jobs in the 

queue, but do not want to print them. 
Substitute CR/LF for LF Check this box to have LF (Line Feed) translated to CR/LF (Carriage 

Return/Line Feed).
Scale font width to fit page Check this box to scale the print font so print lines fit within the

width of the printed page. If this option is not checked, lines that 
extend beyond the page width are truncated. Compression is 
computed using the number of characters specified in the COLS: edit 
box in the Page Layout dialog box. 

Send raw data to printerCheck this box to send data directly to the printer without formatting. 
Use this setting if the data contains imbedded printer control 
commands.

Suppress initial form feed Check this box to suppress any form feeds (blank pages) at the
beginning of a print job.

Append form feed to end of job Check this box if the "Send raw data to printer" option is used 
and the raw data does not contain a trailing form feed.



Use line per inch: Check this box to specify the number of lines per inch to be printed on 
the page.

SNA Character String (SCS) Printer Check this box to indicate an SCS printer. AS/400 and 
IBM mainframe computers can create SCS format print files.

Host Code Page Specify a host language code page. The code page determines the 
EBCDIC to ASCII character translations for the print job. SDI supplies 
code pages for many countries (for example, GermAust.cpgand 
France.cpg). Click the Change... button to display your current code 
page in the Code Page Setup dialog box. If you wish to select a new 
code page, click the Browse... button in the Code Page Setup dialog
box to display the Select Code Page File dialog box and select a new
.cpg file. If no code page is specified, the default code page is used.



Page Layout dialog box
Setup, Print Queues..., queue_name, Page Setup... button

Select page margins, size and orientation.

Margins
Left Specify the width of the left margin. 
Right Specify the width of the right margin.
Top Specify the width of the top margin.
Bottom Specify the width of the bottom margin.

Orientation
Portrait Specify portrait. 
Landscape Specify landscape.

Page Size
Rows Specifies the number of rows per page
Columns Specifies the maximum number of characters on a 

print line. If this specification is less than the width of 
a print line received from the host, the print line is 
truncated. This value is also used for calculating font 
compression when the Compress font width to fit 
page option is checked. 



Code Page Setup dialog box
Setup, Print Queue, queue_name, Change... button 

Use the Code Page Setup dialog box to select a host language code page (*.cpg) file. The code page determines 
the character translations. SDI supplies code pages for many countries. The Code Page Setup dialog box contains 
the following fields:

Drop-down list box Select a code page from the code pages available in the working 
directory.

File name File name of the currently selected code page.
Translation table EBCDIC and ASCII representations for each character in the language 

code page.

Select a code page from the drop-down list box, or enter the file name of a new code page in the File name edit box, 
or click the Browse button and select a new code page from the Select Code Page File dialog box.

The SDI-supplied code pages must never be modified. If you need to tailor a code page to meet your needs, make a 
copy of the SDI code page file that is closest to what you need. Modify your copy of the code page to fit your needs 
with a word processor. Save it with a unique name. You may now select your code page just as you would select one 
of the SDI-supplied code pages.



Run in System Tray (Setup menu)
Setup, Run in System Tray

Toggle the application to or from the system tray. This menu item contains a check mark when the Run in System 
Tray option is active.



Trace Socket command (Setup menu)
Setup, Trace Socket... 

Use this diagnostic command to trace socket activity. Normally you will not use this command unless requested to do 
so by SDI technical support. 

To run a trace, perform the following steps:

1. Start TN3270 Plus LPD. 

2. Start the trace. 

a) Open the Setup menu and click on Trace Socket...

b) In the Select Trace File Name dialog box, specify a name for the trace file and note the folder that it is 
in. 

3. Receive the failing print job.

4. Stop the trace. Open the Setup menu and click on Trace Socket...

5. E-mail the trace file and a description of the problem to trace@sdisw.com.



Help Topics (Help menu)
Help, Help Topics

Use this command to display the contents of the TN3270 Plus LPD Help file.    From the opening screen, you can 
jump to step-by-step instructions for using TN3270 Plus LPD and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening screen.



About TN3270 Plus... command (Help menu)
Help, About TN3270 Plus... 

Use this command to display the copyright notice, version number and build date of your copy of TN3270 Plus LPD.



Restore command (System Tray menu)
Right-click system tray icon, Restore

Use this command to restore the TN3270 Plus LPD window after it has been minimized to the system tray icon 
(Setup, Run in System Tray). 



About command (System Tray menu)
Right-click system tray icon, About

Use this command to display the copyright notice, version number and build date of your copy of TN3270 Plus LPD.



Exit command (System Tray menu)
Right-click system tray icon, Exit

Use this command to exit TN3270 Plus LPD.



Toolbar
View, Toolbar

The standard toolbar is displayed across the top of the application window, below the menu bar. 

To hide or display the standard toolbar: Choose Toolbar from the View.

Click To...
Print the selected job(s) from the print queue.

Delete the selected job(s) from the print queue.

Open the help file.

Status Bar
View, Status Bar

The status bar is displayed at the bottom of the application window.    To display or hide the status bar, use the Status
Bar command in the View menu.



control file 
An LPD control file contains the following information. Each 
piece of information is preceded by a symbol indicating the 
type of information:

Symbol          Description                                            
H                              Originating host
P                              User identification
J                              Job name for banner page (optional).
L                              Print banner page (optional).
M                            Mail when printed (optional).
f                                print formatted file.
l                                print file leaving control characters.
o                              print postscript output file.

daemon 
A background process usually started at system initialization 
that runs continuously and performs a function required by 
other processes. 

Evaluation Version/Unlicensed Version/Licensed Version
The evaluation version will run for 30 days. After 30 days the evaluation 
version will no longer run.

To receive a licensed version, you must register the product with SDI. See the
registration form included in this help file.

fixed-pitch font
A font in which all the characters are the same width. For example "W" is the 
same width as "i". In a variable-pitch (proportional) font, different characters 
have different widths. For example, a "W" is wider than an "i". A fixed-pitch 
font is required to align the characters in columns on a screen or printer. 
Courier and Courier New are fixed-pitch fonts.

This is Courier New, a fixed-pitch font.
This is Arial, a variable-pitch font.

LPD
Line Printer Daemon - Receives print jobs from a Line Print 
Requestor (LPR) and prints the jobs on a printer.

LPR
Line Print Requester - Sends print jobs via TCP/IP to a remote 
computer running a Line Printer Daemon.




